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Pro Tools 8.0.4 Release Notes 
For Pro Tools HD, LE, and M-Powered Systems 
 
The following is a select list of fixes in Pro Tools 8.0.4: 
 
 
 
Editing 
 
Editing can get slow when Separate Region Operates on All Related Takes preference is enabled 
(Item #PTSW-2989) 
OS/Platform: All  
Area: Editing 
Editing could get sluggish when the Separate Region Operates on All Related Takes preference was 
enabled. 
 
Incorrect visual feedback when moving regions up and down on tracks (Item #PTSW-3006)	
  
OS/Platform: All 
Area: Editing  
With a mixture of track formats (i.e. stereo and mono), Pro Tools could display incorrect visual feedback 
when dragging regions up/down on tracks. This was especially problematic when using mini or micro track 
view, as the yellow region outline would indicate that you could successfully drop a mono region onto a 
mono track, when in fact the mouse was hovering over a stereo track. 
 
Dragging a region in Shuffle mode beyond visible area of screen doesn't scroll the screen. (Item 
#PTSW-3040) 
OS/Platform: All 
Area: Editing 
Dragging a region earlier or later in Shuffle mode beyond the visible area of the screen didn't scroll the 
screen. 
 
When the cursor is at the beginning of a region, Control-Tab (Mac) or Start+Tab (Windows) is not 
behaving correctly. (Item #PTSW-3110)  
OS/Target: All 
Area: Editing 
When the cursor is at the exact beginning of a region, Control+Tab (Mac) or Start+Tab (Windows) is not 
selecting that region, rather it skips it and selects the following region. 
 
Tool cursor turns into mouse pointer when editing (Item #PTSW-10248) 
OS/Target: Mac/All 
Area: Editing 
On Mac, the tool cursor would turn into the regular mouse pointer when clicking to perform an edit. 
 
Cannot create a fade at the front of a region with the Smart Tool. (Item #PTSW-10259)  
OS/Target: All 
Area: Editing 
The Smart Tool would not allow creation of a fade in at the beginning of a region. 
  
Making edit selections can become sluggish in sessions with lots of edit groups (Item #PTSW-
120692) 
OS/Platform: All 
Area: Editing, Groups 
Making edit selections could become sluggish in large sessions with lots of edit groups. This has been 
improved. 
 
Audio files remain on the hard drive when cancelling a Consolidate operation before it completes. 
(Item #PTSW-121430) 
OS/Platform: All 
Area: Consolidate 
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When cancelling a consolidate operation before completion, the files would remain on the hard drive. 
Importing these files into Pro Tools would cause errors. Cancelling a consolidation now removes the files 
from the hard drive. Undoing a consolidation also removes the consolidated files from the drive. 
 
Page up/down/end/home keys stop working temporarily (Item #PTSW-122686) 
OS/Platform: All 
Area: Editing 
After making an edit or timeline selection using the start/end fields, the page up/down/end/home keys stop 
working until the selection is modified. 
 
Zooming out with single zoom doesn't always return to previously used tool (Item #PTSW-124704) 
OS/Platform: All 
Area: Editing 
In certain cases, Pro Tools doesn't always return to the previously used tool when using option-Zoom (Mac) 
or alt-Zoom (Windows) with the single zoom tool. 
 
Option-selecting all track names can take several seconds in some cases (Item #PTSW-121981) 
OS/Platform: All 
Area: Editing 
With Link Track and Edit Selection and Link Timeline and Edit Selection enabled, option-selecting all track 
names in the session could take several seconds. 
 
 
Recording 
 
Can't play, record or edit while waveform overviews are being calculated after a record pass. (Item 
#PTSW-56807) 
OS/Platform: All 
Area: Recording 
After a record pass, Pro Tools calculates several sets of waveform overviews. Depending on whether the 
"Pause Tasks During Playback" preference is enabled, you cannot playback/record or perform edits during 
the calculation. Beginning in Pro Tools 8.0.4, overview calculation after a record pass is always paused 
during playback/record, regardless of how the preference is set. This allows editing and playback/recording 
immediately after a record pass. Additionally, waveform calculation after a record pass is no longer 
displayed in the Task Manager. These changes only apply to overview calculation after a record pass.  
 
Audio files cannot be renamed while recording (Item #PTSW-57337) 
OS/Platform: All 
Area: Recording 
In Pro Tools 8.0.3, it was not possible to rename existing audio files on a track or in the region bin while 
recording. 
 
Hang after recording with Waveforms set to Power view (Item #PTSW-120992) 
OS/Platform: All 
Area: Recording 
Pro Tools could hang for several seconds or minutes after a record pass if View>Waveforms was set to 
Power. The exact length of the hang was dependent on the length of the recording and number of tracks. 
 
Waveform could disappear during record pass with Continuous Scrolling or Center Playhead (Item 
#PTSW-56841) 
OS/Platform: All/HD and LE with Complete Production Toolkit and DV Toolkit 2 
Area: Recording 
When using Continuous Scrolling or Center Playhead, the waveform and red record fill could disappear 
during a record pass (even though recording continued). 
 
Crash when the Adjust Fades dialog is prompted during record (Item #PTSW-125770) 
OS/Platform: All 
Area: Fades, Recording 
If the user is creating fades and recording simultaneously, Pro Tools could crash if the Adjust Fades dialog 
is prompted and the recording ends while the dialog is still open. 
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Import Session Data 
 
It is not possible to import track color from other sessions. (Item #PTSW-122215) 
OS/Platform: All/ HD and LE with Complete Production Toolkit and DV Toolkit 2 
Area: Import Session Data 
Track color can now be imported via Import Session Data. 
 
Error in Task Manager when Importing Session Data from some sessions 
OS/Platform: All 
Area: Import Session Data 
Pro Tools could post an Assertion error in the Task Manager when Importing Session Data from some 
sessions when specific import settings were used. 
 
 
 
Automation 
 
When writing plug-in automation in Latch mode, stopping the pass may cause Pro Tools to store 
different automation data than what was written during playback. (Item #PTSW-120728) 
OS/Platform: All  
Area: Automation 
In some cases, plug-in automation written in latch mode could contain an incorrect automation spike beyond 
the position where playback was stopped. 
 
In some cases when using Latch/Trim automation mode with ADC enabled, Pro Tools could 
mistakenly write automation to the end of the session. (Item #PTSW-121140) 
OS/Platform: All/HD 
Area: Automation 
In sessions with automatic delay compensation enabled and more than 500 samples of system delay, Pro 
Tools could intermittently write Latch/Trim automation to the end of the session instead of only writing to the 
stop point.  
 
Pan automation not retained correctly when dragging regions from stereo track to two mono tracks 
(Item #PTSW-2939) 
OS/Platform: All  
Area: Automation  
If pan automation break points were created at the head/tail of a region on a stereo track so that it was 
panned hard left/right, the correct automation values were not retained when dragging that region to two 
mono tracks. 
 
Nudging a fade causes underlying automation to ramp incorrectly (Item #PTSW-2942) 
OS/Platform: All 
Area: Automation 
Nudging a fade with the +/- keys would cause underlying automation to "ramp up" to the fade. 
 
Using the trim tool to adjust automation on a selected region could cause automation to ramp (Item 
#PTSW-2944) 
OS/Platform: All 
Area: Automation 
In some cases, using the trim tool to adjust automation on a selected region containing automation 
breakpoints could cause the automation to ramp incorrectly. 
 
Automation can ramp when TCE Trimming a region in Shuffle mode (Item #PTSW-126552) 
OS/Platform: All 
Area: Automation 
Automation could ramp improperly when TCE Trimming a region in Shuffle mode. 
 
When a track is in the latch automation mode, moving an automated plug-in from one insert slot to 
another during playback causes the latch to be triggered. (Item #PTSW-2946) 
OS/Platform: All/HD 



Pro	
  Tools	
  8.0.4	
  Release	
  Notes	
  —	
  July	
  7,	
  2010	
   4 

Area: Automation 
Moving an automated plug-in from one insert slot to another during playback while a track is in latch 
automation mode could cause the latch to be triggered, and potentially overwrite existing automation. This 
could only occur if the Allow Latch Prime in Stop preference was enabled. 
 
Automation breakpoints get deleted when nudging regions (Item #PTSW-2987) 
OS/Platform: All  
Area: Automation  
Automation breakpoints at the beginning of a region could get deleted when nudging a region earlier in time. 
 
Trying to delete automation inside an object-selected region results in region being deleted (Item 
#PTSW-3011)  
OS/Platform: All 
Area: Automation, Editing 
Trying to delete automation inside an object-selected region results in region being deleted. When object 
selected and in an automation view such as volume, only the automation should be deleted. 
 
DAE -9155 Automation Too Dense errors (Item #PTSW-3049) 
OS/Platform: All/HD 
Area: Automation 
Pro Tools would sometimes post DAE -9155 Automation Too Dense errors during playback. Automation 
performance has been optimized in Pro Tools 8.0.4.  
 
Final breakpoint sometimes not written on stop when using Latch or Touch/Latch mode (Item 
#PTSW-57275) 
OS/Platform: All 
Area: Automation 
Intermittently, the final automation breakpoint was not written upon hitting stop when using Latch or 
Touch/Latch.  
 
Automation can only be thinned on visible parameters (Item #PTSW-125786) 
OS/Platform: All 
Area: Automation 
Added a new Thin All command which when selected, thins all automation parameters on selected areas of 
tracks, even if those parameters are not visible. The new command is located at Edit>Automation>Thin All 
(Pro Tools HD and LE with DV Toolkit 2 or Complete Production Toolkit) and Edit>Thin All Automation (Pro 
Tools LE and M-Powered). 
 
 
 
QuickTime 
 
Playback start time is delayed when session contains QuickTime video and Mac Sound Input or 
Output is set to Digidesign HW. (Item #PTSW-2940) 
OS/Platform: Mac/All 
Area: QuickTime 
Pro Tools could experience a delay before starting playback in sessions containing QuickTime movies if the 
Macintosh Sound input or output was set to Digidesign hardware. This has been resolved. 
 
 
 
Miscellaneous 
 
Interleaved WAV file track ordering and support for WAV_Format_Extensible files (Item #PTSW-2948) 
OS/Platform: All 
Area: Surround, Import 
Interleaved 5.1 WAV files created by 3rd party applications such as Steinberg Nuendo with SMPTE/ITU 
track ordering would import into Pro Tools with the incorrect track order. This has been resolved. 
Additionally, Pro Tools 8.0.4 can now import and playback WAV_Format_Extensible files from applications 
such as Avid DS or Steinberg Nuendo. 
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Hang after committing a relink command (Item #PTSW-3047) 
OS/Platform: All 
Area: Relinking 
In some cases, Pro Tools could hang indefinitely when relinking to missing files that had fade files attached. 
 
Sessions referencing MXF audio files are slow to open (Item #PTSW-122388) 
OS/Platform: All 
Area: DigiTranslator, MXF 
Optimized session open times for sessions referencing MXF audio files. 
 
Crash when opening a session with Canopus ADVC 110 or 100 attached. (Item #PTSW-120430) 
Area: Canopus ADVC 110 or 100 
OS/Platform: Mac/HD 
Pro Tools could crash when opening a session saved with video playing out via Canopus ADVC 110 or 100. 
 
Pro Tools is unable to import audio files from some CD's (Item #PTSW-123245) 
OS/Platform: Mac/All 
Area: CD Importing 
Pro Tools is unable to import audio files with names containing the characters : or / from CD's which have 
been cataloged by iTunes. Dragging files from the CD to Pro Tools causes a crash, the Import Audio dialog 
does not allow you to select the files for import, and the Workspace browser doesn't display the CD at all. 
 
Digidesign Hardware unavailable when attempting to use some 3rd party applications with Core 
Audio Manager (Item #PTSW-120492) 
OS/Platform: Mac/HD and LE 
Area: Core Audio 
The Digidesign Hardware was unavailable when attempting to set some 3rd party applications such as 
Reason and Cubase to output audio through Pro Tools HD, Digi 002, or 003 systems. 
 
Right side of stereo region is silent after consolidating audio on an Elastic Audio track. (Item 
#PTSW-56787) 
OS/Platform: All 
Area: Elastic Audio 
In some cases, the right side of a stereo region would be silent after consolidating multiple regions with 
fades on a stereo track with Elastic Audio enabled. 
 
coreMIDI.framework gets launched in the Dock when other 3rd party audio applications are launched 
(Item #PTSW-68025) 
OS/Platform: Mac/All 
Area: 3rd party applications, MIDI 
coreMIDI.framework gets launched in the Dock when other 3rd party audio applications are launched. This 
has been resolved.	
  
 
Lost Hardware Communication DAE -9161 error on session close (Item #PTSW-120644) 
OS/Platform: All/HD 
Area: Session Close 
Pro Tools sessions could get into a bad state after experiencing a DAE -9161 Lost Hardware 
Communication error on session close. 
 
Waveforms are not automatically re-drawn when a disk volume is taken offline and then put back 
online (Item #PTSW-122026) 
OS/Platform: All 
Area: Waveforms 
This could occur when a disk volume containing audio files in the session (but not the session itself) was 
taken offline and then brought back online, or if a similar volume was switched to Transfer in the Workspace 
browser, and then set back to Record or Playback. 
 
Looped region cannot be analyzed for groove template extraction (Item #PTSW-122123) 
OS/Platform: All 
Area: Beat Detective 
Fixed a crash or access violation that could occur when attempting to analyze regions looped 3 or more 
times for groove template extraction via Beat Detective. 
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Intermittent noise bursts during playback (Item #PTSW-122506) 
OS/Platform: Windows/All 
Area: Playback 
In some cases, Pro Tools HD on Windows XP could intermittently emit white noise bursts or distortion during 
playback. 
 
Some plug-ins become non-operational after accidentally pressing the Windows Start key (Item 
#PTSW-121008) 
OS/Platform: Windows/All 
Area: Plug-ins 
Inadvertently pressing the Windows Start key when closing some plug-ins could cause the user interface of 
other plug-ins to freeze or not function properly. 
 
With a D-Command connected, some sessions could crash on open (Item #PTSW-124058) 
OS/Platform: All/HD 
Area: D-Command 
With a D-Command connected, some sessions could crash on open with a "Segmentation Fault" error. This 
did not affect D-Control. 
 
Volume spike during playback (Item #PTSW-121112) 
OS/Platform: All/HD 
Area: Playback, Delay Compensation 
In some workflows, initiating play in a session with delay compensation enabled could intermittently cause a 
momentary volume spike. 
 
In some scenarios, the right channel can disappear (Item #PTSW-16693) 
OS/Platform: All/HD 
Area: Mixing 
When the stereo mixer uses 100% of an HD Accel DSP, it was possible for the right output of a master fader 
or aux track to disappear. 
 
Levels on Sends F - J can adopt levels from other sends (Item #PTSW-120265) 
OS/Platform: All 
Area: Mixing 
When displaying individual send faders (rather than Assignments), changing a level on one send can 
propagate that same level to other sends within F - J. 
 
Incorrect fades when using Satellite Link and Destructive Punch (Item #PTSW-122894) 
OS/Platform: All/HD 
Area: Satellite Link, Destructive Punch 
When using Destructive Punch mode to dub between multiple Pro Tools HD systems connected via Satellite 
Link, the crossfades could be incorrect when stopping playback from the player system (rather than stopping 
from the recorder system). 
 
When entering a text input field on a non-English operating system, the input language/source 
would be toggled to the operating system's language (Item #PTSW-3029) 
OS/Platform: All 
Area: Input Language, Input Source 
Pro Tools 8.0.4 adds a new "Auto-Switch Input Language" preference. When checked, the input language is 
auto-switched. When unchecked, the used input language is used. On non-English Windows operating 
systems, an issue exists when the input language is set to English. Pro Tools will stay in English regardless 
of how the "Auto-Switch Input Language" preference is set. The workaround is to set your input language to 
the operating system's language. 
 
No audio output after opening several sessions with DSP Cache enabled (Item #PTSW-2980) 
OS/Platform: All/HD 
Area: DSP, Mixing 
With DSP Cache enabled, Pro Tools could get into a state where plug-ins would be made inactive and the 
session would fail to output audio. This would occur after opening/closing multiple sessions with DSP Cache 
enabled. 
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Crash or error when creating a new track after AudioSuite preview (Item #PTSW-128328) 
OS/Platform: All 
Area: AudioSuite 
Pro Tools could sometimes crash, post an Access Violation, or DAE -7453 error when creating a new track 
immediately after an AudioSuite preview. 
 
Kernel Panic when shutting down Mac if Mbox 2 was disconnected previously (Item #PTSW-56617) 
OS/Platform: Mac/LE 
Area: Mbox 2 Family (USB) 
Mac computers would kernel panic (crash) on shut down if the computer was started with an Mbox 2 USB 
device (Mbox 2, Mbox 2 Mini, or Mbox 2 Micro) attached, and the Mbox 2 is disconnected prior to shutdown. 
 
Core Audio Manager crashes when launching some 3rd party applications with Mbox 2 devices (Item 
#PTSW-125131) 
OS/Platform: Mac/LE 
Area: Core Audio 
Core Audio Manager crashes when launching applications such as FM8, Massive, or Absynth 5 when an 
Mbox 2 device is connected. This would occur if Core Audio Manager was installed and Digi CoreAudio 
Device was selected in System Preferences>Sound>Output. The crash has been resolved. However, 
because Mbox 2 devices are full Core Audio clients, it is not necessary to use Core Audio Manager with 
them (this is only necessary with Digi 002, 003, and Pro Tools HD). With Mbox 2 family devices, you can 
simply select Mbox 2 in System Preferences>Sound>Output. 
 
 
 
MIDI 
 
Cutting or inserting time in sessions with meter or tempo changes was creating partial bars. (Item 
#PTSW-56815) 
OS/Platform: All 
Area: Time Operations 
Cutting or inserting time in Bars|Beats ruler mode now adjusts the meter map. For example, cutting 1 beat 
from a 4/4 bar will now create a 3/4 bar. For ruler modes other than Bars|Beats, there is now an option to 
realign "Tempo Ruler Only" when cutting or inserting time. Selecting this option will speed up or slow down 
the session tempo to match the cut or inserted time. 
 
Cut Time or Insert Time Edits in MIDI Event Window (Item #PTSW-122505) 
OS/Platform: All 
Area: MIDI 
Performing Cut Time or Insert Time edits from a selection in the MIDI Event Window did not create new 
meter changes in the main Edit window. 
 
MIDI channel assignments can sometimes change from channel 1 to channel 2 when re-activating an 
inactive instrument track. (Item #PTSW-2949)  
OS/Platform: All  
Area: MIDI 
Intermittently, an instrument track assigned to MIDI channel 1 would switch to channel 2 if the track was 
made inactive, and then re-activated. 
 
Wait for note not working properly (Item #PTSW-3013) 
OS/Platform: All 
Area: MIDI 
On Windows systems, Pro Tools would not go into record when using Wait for Note. This has been 
resolved. On both Mac and Windows, an issue still exists with Wait for Note in which the click may stutter at 
the downbeat after Pro Tools goes into record. The workaround is to set the Duration to a low value such as 
10 ms for both Accented and Unaccented in Setup>Click/Countoff Options. Beginning in Pro Tools 8.0.4, the 
Accented and Unaccented Duration now defaults to 10 ms (previously 100) for new sessions. Users with 
existing sessions will need to manually change the Duration. The Duration setting affects some external 
MIDI devices, but does not affect the Click plug-in.  
 
Moving notes in Score Editor could affect notes or rests in another bar. (Item #PTSW-3015) 
OS/Platform: All  
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Area: MIDI 
In some cases, moving a note in Score Editor could cause a note or rest in another bar to move. 
 
Making selections on MIDI tracks which are part of an edit group (Item #PTSW-126115) 
Platform/OS: All 
Area: Editing, MIDI 
Making selections on MIDI tracks which are in notes, velocity, or blocks view, and are also part of an edit 
group, will now propagate the selection to other Audio and Aux tracks in the group. 
 
 
 
MachineControl 
 
Title: 9-pin Remote Mode with session start times before 00:00:00:00 (Item #PTSW-2945) 
OS/Platform: All/HD 
Area: MachineControl 
When in 9-pin Remote Mode, Pro Tools does not play when the session start time is before 00:00:00:00, 
and playback is started anytime after 00:00:00:00. For example, this would occur if the session start is 
23:59:00:00 and playback is started at 00:00:30:00. 
 
Sony SRW-5800 deck not automatically recognized (Item #PTSW-120808) 
OS/Platform: All/HD 
Area: MachineControl  
Pro Tools now automatically recognizes the Sony SRW-5800 deck and track arming profile. 
 
Crash when rewinding after capturing from a deck using MachineControl (Item #PTSW-124090) 
OS/Platform: Windows/HD  
Area: MachineControl  
Pro Tools could post an Access Violation, Runtime error, or Fatal Exception and crash when attempting to 
rewind immediately after capturing from a deck using MachineControl. This would occur if the rewind 
command was issued before waveforms were drawn. 
 
It is not possible to punch into more than 48 tracks simultaneously from a 9-pin paddle controller 
(Item #PTSW-125243) 
OS/Platform: All/HD 
Area: MachineControl, Destructive Punch 
Pro Tools is now compatible with higher track counts for simultaneous record punch in that are offered by 9-
pin paddle controllers such as the Soundmaster Virpad or Colin Broad PD-1. Pro Tools can now punch up to 
64 tracks simultaneously. 
 
Edit window stuttering during pre-roll with MachineControl (Item #PTSW-3012) 
OS/Platform: Mac/HD 
Area: MachineControl 
When initiating playback while Pro Tools is online with a 9-pin device with MachineControl, the Edit Window 
can stutter during the pre-roll. 
 
 
 
Avid Unity ISIS, MediaNetwork, and shared storage 
 
Changing user on shared storage system while Pro Tools is launched does not update user access 
rights. Pro Tools must be re-launched for changes to be applied. (Item #PTSW-3021, 57201) 
OS/Platform: All 
Area: Shared Storage, Avid Unity 
Previously, when changing users on a shared storage system such as Avid Unity ISIS, Pro Tools would not 
update its user access privileges for workspaces until Pro Tools was re-launched. Thus, a user who should 
have read/write permissions on a given workspace may have read only access. This has been resolved. 
 
Pro Tools holds onto extra disk space after calculating waveform overviews on Avid Unity (Item 
#PTSW-3016) 
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OS/Platform: Windows/HD 
Area: Avid Unity  
Pro Tools would hold onto extra unnecessary disk space after calculating waveform overviews. This could 
occur after a record pass, or after opening a session created in Pro Tools 7.x in Pro Tools 8.x. The problem 
was more severe on Unity MediaNetwork systems, although Unity ISIS was affected as well. 
 
 
 
Interplay 
 
Exporting the same sequence more than once from Pro Tools back to Interplay can cause Pro Tools 
to hang or the sequence to become corrupted (Item #PTSW-3097) 
OS/Platform: Win XP/HD 
Area: Interplay 
When exporting the same sequence more than once from Pro Tools back to Avid Interplay, Pro Tools could 
either hang, or the sequence would become corrupted. When the sequence is corrupted, Media Composer 
would post the following error when attempting to import or update the sequence, "A request for data from 
the asset manager is taking a long time to complete." 
 
After Pro Tools has checked in audio tracks to a sequence in Interplay, the resulting Video Master 
clips do not link to Archived media (Item #PTSW-47825) 
OS/Platform: Win XP/HD 
Area: Interplay 
If clips in Media Composer are archived to Avid Interplay Archive, and a sequence containing those clips are 
then checked into Interplay for Pro Tools, and then checked back out of Pro Tools into Interplay, the new 
resulting master clips from Pro Tools are not linked to the original clips on Interplay Archive. 
 
Sub clip associations are lost when checking into Interplay from Pro Tools using Replace Tracks on 
sequences that original contained sub clips. (Item #PTSW-51208) 
OS/Platform: Win XP/HD 
Area: Interplay 
When checking into Interplay from Pro Tools using Replace Tracks, if the original sequence contained sub 
clips, the sub clips associations were broken. A master clip in Media Composer would show as a video only 
master clip, when there should be audio clips associated. Attempting to load a sub clip would post the error, 
"Track -1 not found". This has been resolved. 
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